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TOPICAL DESCRIPTION OF SOFTW ARE 

In the following sections, topics of operation are discussed in alphabetical order 

1. Calibration and Setup 

2. 

3. 

3. 

4. 

5. 

a. Introduction to applet 13 
b. Outline of steps 14 

c. Hardware configuration 14 

d. Software configuration 15 

e. Establishing stmting calibration values 17 

f. Run DAC to calibrate BE span 19 

g. Run Detector Width Calibration 20 

h. Run VI curves 21 

I. Signature conection 
Database Functions 
a. Creating a new database 
b. Get recipes from another database 
Depth Profiles 
a. Creating a new database 
b. Get recipes from another database 
Depth Profiles 
a. Open the depth profile table generator 
ESCA Control Panel 
a. Unscanned mode 
b. Scanned Mode 
c. Quick survey 
Experiment Names as part of the database structure. 
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6. Graphics controls 
a. Chart editor 36 

b. User Preferences 38 
c. Print Utility 39 

d. Spectrum color 41 

e. Clipboard 41 

7. Motion Control 
a. Angle Resolve and tilt stage setup 42 

b. EnablefDisable Buttons 47 

c. Home controls 47 

d. Mode control of the Joystick buttons (6K4) 48 

e. Panic Button 50 

f. Position Table Setup 51 

g. Rotation 54 

h. System Configuration (GPIB, 6K4, disable axes) 55 

l. Units, coordinates 56 I 

j. Velocity Setup (GPIB with 2100 Indexers) 57 ' 

8. MRS Tables 58 : 

a. Construction by selecting and editing Functions 59 

b. Templates 62 

c. Run Controls 63 

Software conventions 

1. When text boxes are White they will accept data entry. 

2. When text boxes are Blue they are read only. 

1. VV!JCll lCJl.l UUJl.C~ 'UC vv IIIlC lllCY WIll a\':\':cpl uala t:nlry . 

2. When text boxes are Blue they are read only. 

3. Buttons or labels that are Red indicate something is turned off. 

4. Buttons that are Green indicate something is turned on. 

5. Buttons that are Yellow indicate something is turned on but temporarily not in 

a useable state. 
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New Capture Desktop - Experiment Mode 

Experiment Tree 
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A Quick is no longer available. There is no requirement to create a recipe. When in 
Experiment Mode, simply edit the MRS table to create a parameter set for the next data 
acquisition. The MRS table will be stored with the data. 

The Experiment Tree shows the past experiments. Selecting an experiment will recall the 
stored MRS table. You have four options: 

The Experiment Tree shows the past experiments. Selecting an experiment will recall the 
stored MRS table. You have four options: 

1. Run MRS table with a new Project/Experiment name. 
2. Modify MRS table and run with new Project/Experiment name. 
3. Overwrite recalled Experiment. 
4. Save MRS table as a Recipe. To save MRS as a recipe use File menu, Save 

As - Recipe. 

The Clear button provides a quick way to start a new MRS table. Don't worry about the 
existing MRS table. If it has been run it is saved. All MRS tables saved with 
experiments have the Recipe name "None". 
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New Capture Desk Top - Recipe Mode 
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1. Save Recipe. Requires Recipe Mode. Saves current 
state of MRS table to active recipe. Save Icon causes 
same action. 

2. Save As - Recipe creates a new Category/Recipe. 
May be used from Experiment Mode. 

3. In Recipe Mode changes to MRS are NOT saved 
unless the Save Recipe or Save Icon is used. Recipes 
should not be changed after they are established. This 
can cause unexpected results in linked Position Tab 
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To create a new recipe just Clear the current MRS table and then compose a new table. 
I ' , ~I"wl _ ____ _ __ _ 
r;.. ~/:ZW .. . Co.II~2~- fI ~2p Ild(Pi JJ.,ep; Pt-~I Rb~ ~.(I~.wJ -

To create a new recipe just Clear the current MRS table and then compose a new table. 
Then to turn the MRS table into a Recipe: 

1. Go to File menu and select Save AS - Recipe 
2. File out the Category name, Recipe name and description. 
3. You can browse to an existing Category and then edit the Recipe. This provides a 

fast way to add Recipes in a sequence. 
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Export of Raw Data 
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1. Select an Experiment. If only some regions are to be exported mark them visible. 
2. Select Export in the File menu . 
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3. Choose All regions or Only Visible regions. Select type of export. 
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Export of Raw Data - Cont. 

The V AMAS export is an ASCII file readable by any text editor. The arrangement of 
infonnation follows the international standard for Surface Science Data. All region of the 
MRS can be included in one V AMAS file. The V AMAS file can hold a complete depth 
profile. This is a very flexible and well-defmed export file . 

To use the Excel export, Excel must be available on the computer running the ESCA 
application. It does not need to be running. The export will open an Excel notebook, fill 
header cells with instrument parameters and provide a column of numbers representing 
the spectrum data. A crude graph is also created for quick review. There will be one 
page per spectrum. All spectra for a MRS table or just the regions marked visible can be 
included. A depth profile can be exported. 

Fakedata.txt is an internal text file used for demonstration purposes. Any spectra can be 
converted to a fakedata.txt file and then used by the Demo program to simulate the 
collection of data. This can be convenient for training and remote investigation of the 
program operation. 
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The Export File Dialog is used with the V AMAS export. This is a standard Windows 
dialog. File storage for the Excel is handled out of the Excel program. 
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ESCA Control Panel- Replacement for A Quick 
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The ESCA control panel is used for direct access to the spectrometer. 
You may change a setup condition and hit start even if a scan is ill progress. The scan 
will automatically abort and restart. The Time/Step can be changed. If scanned is 
checked "Capture T" provides an estimate of the total capture time. The top row of 
controls will change the state of the ESCA when the control is clicked. The eight 
controls in the frame change state when the Start button or Enter Key is hit. 
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Motor Control Panel- GPIB Interface 

View Menu item, Motion Control Pnl 
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1. Configure Motors: 
a. Set type of motion control interface 
b. Tum on/off individual axes. 

2. Velocity Setup: 
a. Set velocity of individual axes. 

3. Home Controls 

4. 

5. 
6. 

a. Set XYZ: Set current XYZ position 0,0,0 
b. Set R: Set current R position 0 
c. GOTO XYZ: Return to XYZ = 0,0,0 
d. GOTO R: Return to R = 0 or 360 
Rotation 
a. Cont. 
b. Stop 
Panic 
Motors: 

Starts continuous rotation. 
Stops continuous rotation. 
Stops all motion and disables Motors. 
Green means Enabled. Yellow means computer control. Red 

means Disabled. 
7. Units: 
). raruc :)tops all motion and dIsables Motors. 
6. Motors: Green means Enabled. Yellow means computer control. Red 

means Disabled. 
7. Units: 

a. XYZ: Set scale system to MM, Inches or number of steps. 
b. Rotation: Set scale system to Deg, nwnber of steps or tilt. 
c. GOTO or Get * IF number is present in any white box then motors 

will move to position. If all boxes empty then computer will get current 
position. This is useful after Joystick movement of stage. * denotes that 
the Enter Key will produce this function if form is active. 
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Motor Control Panel- Ethernet Interface 
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The Ethernet interface and 6K4 controller allow for use of a USB Joystick. The Joystick 
button has three states: 

Green - Enabled 
Yellow - Motion under computer control 
Red - Disabled. This secures the motion system from accidental input while 
running a position table. 

The button labeled "Joystick Buttons" controls the state of the remote buttons located of 
the joystick. Two buttons can be set to update the horne positions or to cause forward or 
back stepping through the position table. The state is toggled between these two 
functions by this button. The message box in red with yellow letters describes the current 
state. 

It will be noticed that one additional difference between the GPIB/21 00 Indexer system 
and the Ethernetl6K4 system is the speed of operation. The Ethernet communication 
provides real time position information during the motion of the stage. The blue read 
only boxes post the position in real time. 

provides real time position information during the motion of the stage. The blue read 
only boxes post the position in real time. 

Page 51 for Position Table Setup 
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Position Table 
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Steps to set up Position Table: 

1. Tool Bar> View> Motion Control Pnl 
2. MRS Table function> PT M > Table Name (Default in this case) > Design 

Button. 
3. Table options: 

a. Create a new table, Clear the displayed table, Delete the displayed table or 

Button. 
3. Table options: 

a. Create a new table, Clear the displayed table, Delete the displayed table or 
Save and run table. 

b. Create a table of positions: 
i. Learn positions using joystick. 

ii. Move to positions using control panel, then transfer to table. 
iii. Numerical entry directly to table. 

c. Table Row controls 
1. Add row 

11. Delete row 
111. Move row up 
IV. Move row down 
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4. Review of positions. 
a. Select "numbered" buttons at end of Row. Stage will move to position. 
b. Select Step forward/Step Back buttons on Table Form. 
c. Select Step forward/Step Back buttons on USB joystick (6K4 controller). 

5. Assign recipes 
a. Select Recipe mode. Click drop down box for each row. Assign Recipe 

from list. 

It is very important to step through all positions before running a table. We have noticed 
that the positions will not be the same on the flrst pass after learning. However, as the 
positions are reviewed buy stepping through them in order, it is easy to refine the stored 
coordinates by using the joystick learn button. The row cursor automatically follows. 
This usually stabilizes the learned positions. 

As the positions are reviewed, be sure limit conditions are not displayed. During the 
running of a position table a limit condition will keep the stage form moving to the 
correct position. You will be notified if this occurs. 

To run the position table: 

1. "Save and Exit" the position table 
2. Enter the Project, Experiment and Experiment description information. 
3. Select the Run (from top) button 

During the collection of data the MRS table will display the individual MRS tables for 
each position. The Experiment Name window will display: 

Your Experiment Name:POS X where X is the position number. 

For more details on Position tables See "Position Table Setup" pg 51 
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Calibration and Setup - Outline of steps 

It is velY helpful if the calibration parameter values, from the previous 
software, are available. IF you are upgrading from ESCA VB without a 
change of operating system these steps are not required. If a new operating 
system was installed then proceed with calibration. 

1. Configure the registry entries for the ESCA system hardware. 
2. Configure calibration parameter values that were used in previous software. If 

these are not available then develop a rough set of starting values. 
3. Run DAC to calibrate the span of the BE scale. 
4. Run Detector Width to calibrate the detector and set the absolute BE. 
5. If the ESCA Instrument has a VI (lens focus voltage) supply in the 

Spectrometer Power Supply that is digitally controlled then run V 1 calibration 
curves. 

6. Return to the main program and set up Signature correction. 

Calibration and Setup - Hardware configuration 

Use the main tool bar and select the Settings menu. Select Capture Settings. 

li tile ~iew f"Settings tielp E"it 

JI D d ~.~ Set System Registry Defaults 

C Recipe 
r. E~perime 

Edit Scofield Table 

Set up ESC A 

Create a new Signature file 
,~ . Default ------------' 

[1j Temp 

on 
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Calibration and Setup - Hardware configuration - Detector 

Select the Detector Tab in the Dialog. If a valid signature file is available then check the 
Signature Correction ON box. If this is a new installation then see Signature Correction 
section below. 

If the "Signature file could not be loaded" message was displayed during the startup of 
the program check the Signature File Path. The sig.txt file, that holds a valid signature, 
must be available. The installation will make a dummy sig.txt file that makes no 
signature correction. It is loaded in the ESCA 2000 folder. To use this default file make 
sure the path points to the ESCA 2000 folder. If you set up a custom folder then enter 
the custom path statement in the Signature file Path window. 

The Dither box should be checked if a 2502 fast detector and 2503 buffer memory are 
used. Ifa 2401 Position computer is used do not check the Dither box. 

Horizontal Linerization is not available in this release. 

Iii . Capture Settings 

Detector X·Rays Spectrometer I 

r Signiture Correction ON 

Signature File Path: IC:\Program Files\ESCA 2000\sig.txt 

r Dither 

r Horizontal Linerization 

I [" .... ·· .. ·i~~~~i .. · ........ ll 
,......... . ...... , ...... ~ .......... , 

Update 
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Calibration and Setup - Hardware configuration - X-Rays 

Standard settings for a Monochromator system. 

A. Source Type: Al 
B. Filter: Monochromator 
C. Reference Energy: 1486.6 is provided as the accepted value 
D: Please select the type of X-Ray gun controller 

Note: "Other" is used for X-Ray guns that are not controlled from this 
software. The VG 8730 can be controlled using the 8702 LIS. 

Iiio . Cdplure Sellirigs __________ ~ ________________ ~ IDI~ 

Detector X-Rays Spectrometer 

-------

Source Type IAI 3 Reference Energy 11486.6 

Filter IMonochromatori] Spot controller 18702 Spot 

Satellite Subtraction Parameters 

Satellite Offset Amplitude Filter Transmission Fraction 

Near Pk Far Pk 

I [ .... ~: . · :.~~~i~~: ... :.-.. ::ll Update 

Non-Monochromator Systems 

A. Select source Type from list 
B. Select None or Foil. 

None will establish a list of satellite peaks with full intensities as specified in the 
literature. Foil will allow adjustment of the satellite intensities. This is an empirical 
process. We assume the satellites are attenuated by the window foil. The Filter 
Transmission Fraction is the Transmission for the satellite peak compared to the Primary 
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peak. The Transmission Fraction can be specified for the satellite nearest the Primary 
peak and the satellite farthest from the Primary peak. A linear variation in transmission is 
computed for the intennediate peaks. 

The Filter Transmission Fractions are determined by collecting a spectrum and then using 
the Satellite subtract function in the Tools menu found at the top of the spectrum display 
window. Adjust the Filter Transmission Fraction for the Near Peak until the subtraction 
produces a smooth baseline in the region of the near satellite. Then adjust the Filter 
Transmission Fraction for the far peak. You may need to iterate the setting a few times. 
Your fmal Transmission values will be saved with all spectra at the time of capture. The 
satellite subtraction can be performed in the Capture program or the Data Analysis 
program. 

Refer to Satellite Subtraction in the Data Analysis section under Manipulating Spectra. 
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Calibration and Setup - Hardware configuration - Spectrometer 

iii . Capture Settings. ~----------------------~----~~ 

Detector X-Rays Spectrometer 

Spectrometer Power Supply 18701, 8701 B 

Lens Type IX Probe 

\ r·.·.· ... · .. ·-.-~E~ .. ~~-.-... · ... ..ll 

1. Select the type of spectrometer power supply from the drop down list. 
2. Select the type of lens from the drop down list. 

If the Spectrometer Power Supply entry is changed then you must exit the Capture 
Application and re-start it so the instrument interface and be re-initialized. You will be 
reminded of this requirement when the Capture Setting Dialog is closed. 

Updating the Registry 

If vou Cancel the dialoQ' or use the "X" hlltton_ none of the ~hilnpes milrlp. rlllrinp vom 

Updating the Registry 

If you Cancel the dialog or use the "X" button, none of the changes made during your 
session with the Capture Setting Dialog will be saved. You must use the Update button 
to save your changes. The dialog will close after the Updates are complete, so it is 
convenient to make all desired changes before Updating. 
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Calibration and Setup - Calibration Parameters 

To enter calibration parameters into the registry open the Set up ESCA applet. 

11 Eile ~iew t:!elp I Settings E~it 
II [j d f.r ~ I Set System Registry Defaults 
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.r. Experiment 
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Spectrometer Control Panel 

Start Accumulation I 
CenterBe 278 

IMndowlMdth 20 
NumberOtPoints 128 
Nscans I Nreads 1 

Resolution 11 :::oJ 
Scanned '" 

HorizUnearization r 
Dithered r 

Signature r 
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Play Mode 
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Resolution 11 :::oJ 
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r Collect Data Read Once 

FilterCoefficient o 
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Calibration and Setup - Calibration Parameters 

The calibration parameters are entered into the Configuration Table 
located on the Configuration Tab. 

Acquisition Configuration I DetectorWidth I DAC I V1 Curves I 

Refresh 

Ent~ __ I 
BufferMemoryType 
Interrupt Number 
GPI012Base 
GPI013Base 
GPI014Base 
SpotType 
Ctl12Nuil 
Ctl13Nuil 
Ctl14Nuil 
SupplyType 
SupplyRange 
MsResSettleTime 
DetWidthResl 
DetWidthRes2 
DetWidthRes3 
DetWidthRes4 
DetWidthRes5 
PassEvRes1 
PassEvRes2 
PassEvRes3 
PassEvRes4 
PassEvRes5 

configuration are displayed below. You may edit them but 
manent until the commit button has been pressed. 

2412 
5 

Notes - - -- - -- ----,.-'--'-'-----'-- ---
Type of buffer memory board. Must be 2412. 

'------'''------''-'--~ 
errupt number used by buffer memory board 

640 used to communicate with the buffer memory 
704 -----rTm7r-n::>'TTT1r-n::r;:;;ort used to communicate with the analyzer contr 
768 
1 
0 
16 
16 
0 
1 
12000 
3.500000 
7.000000 
13.500000 
20.000000 
1.500000 
30.000000 
50.000000 
100.000000 
150.000000 
15.000000 

DWORD 10 Port used to set the accessory bits. 
DWORD Not used at present 
DWORD Controls logic of strobe handshaking bit. 
DWORD Controls logic of strobe handshaking bit. 
DWORD Controls logic of strobe handshaking bit. 
DWORDo=8701, 1=8701 b, 2=8724 
DWORD Applies to supply type 8724 only: o=Range-l , 1 =Ran 
DWORD Settling time in milliseconds following a change of an 
String If detector coefficients are missing, this value/128 is u 
String If detector coefficients are missing, this value/128 is u 
String If detector coefficients are missing, this value/128 is u 
String If detector coefficients are missing, this value/128 is u 
String If detector coefficients are missing, this value/128 is u 
String Not used at present time. 
String Not used at present time. 
String Not used at present time. 
String Not used at present time. 
String Not used at present time. 

After entering changes to the values you must select the Cornrn.it button to wite the 
changes to the registry. 

Type 5000 for the MSResSettleTime. This will sh0l1en the wait time when the resolution 
Alter entermg Changes to the values you must select the Conumt button to wlte the 
changes to the registry. 

Type 5000 for the MSResSettleTime. This will shorten the wait time when the resolution 
is changed from 12 seconds to 5 seconds. 

If you have calibration values from the HP workstation (9800 series) then one adjustment 
to the calibration values is required. For each Resolution correct the pass energy. Use 
the Detector With for the same Resolution as the Pass Energy. 

New Pass energy = Old Pass energy + (Detector Width)/2 

If you are upgrading from the DOS Vectra software or have installed a new operating 
system then use the pass energy that was previously used. 
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Calibration and Set up - Calibration Parameters cont. 
Make the following entries to the Configuration table if data is available. 

7.282358326 
'15 
21 
1.45 

ts 
s Use Existing Detector 

Widths if available. s 
If detector coefficients String 

String If detector coefficients _ , 

DetWidthRes2 
DetWidthRes3 
DetWidthRes4 
DetWidthRes5 
PassEvRes 'l 
PassEvRes2 59.32277305557 St Enter Pass Energies as 
PassEvRes3 113.5646445856E St discussed above. 

tin 
tin 
tin 

PassEvRes4 166.5961771421C String Not used at present tin 
Not used at present tin PassEvRes5 12.8 String 

Se ns it ivit y Ex pRes 1 _~~~L-__ ....:S~t~r' 
SensitivityExpRes2 
SensitivityExpRes3 
SensitivityExpRes4 
SensitivityExpRes5 

. pe 
Enter Sensitivity Exps 

I

V110ffsetRes1 
V110ffsetRes2 
V10ffsetRes3 
V10ffsetRes4 
'V110ffsetRes5 
V1 SiopeRes1 
V1 SiopeRes2 
V1 SiopeRes3 
V~ SiopeRes4 

V1 SiopeRes5 
DeitaEvSpot1 
DeitaEvSpot2 
DeitaEvSpot3 
De It a EvS p ot4 
DeitaEvSpot5 
XyzMotorsOn 
RMotorOn 
Ueltat:V::ipot4 
DeitaEvSpot5 
XyzMotorsOn 
RMotorOn 
Reode 
Xeode 
Yeode 
leode 
Cal \ID 8701 
Cal \ID 300 8724 - - -
Cal \ID 1500 8724 - - -
Cal VD 3000 8724 - - -
Cal V1 8701 
Cal V1 8701 

142.721457 
226.855499 
100.000000 
0 .423228 
0.442913 
0.492126 
0.545024 

0 .500000 

0.0000 
0 .000000 
0.000000 
0.000000 
o 
8.uuuuuu 
0.000000 
o 

pe 
only if special values pe 
have been established. pe 

g pe 
e \ 

V 1 offsets and Slopes e \ 
for 8701 B or 8724 e \ 

St only. Note values for e \ 
St V 1 curve setup. e \ 
Stn e \ 
String Used to calculate the \ 
String Used to calculate the \ 
String Used to calculate the \ _. 

St ri n Q....---'-'-"'-"''''''--XLl.....<=.LI::.L.1.L=.iOl....Ih e \ 

DeltaEvSpot 
depends on crystal 
adjustment. Do after 
all other adjustments 

Motor parameters, 
all other adjustments 

o tin 
1'106 vie 
1107 eVlc 
1108 DWORD Determines GPIB devie 

1109 DWr DAC for 8701 JVie 
40 OL~ _ Ita. 
640 Stri Ital 
163.9 -===:=::;;;; Ita! 
80.000000 
40.000000 
40.000000 
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Calibration and Set up - Establishing starting calibration values 

If the above calibration values are not available then follow these steps: 

1. Set DetWidthRes4 to 19 eV and the PassEVRes4 to 166 eV. Make these entries 
in the configuration table and use the Commit button to register these values. 
Leave all other values as shipped. 

2. Set up a gold sample and be sure all supplies are on. Set the X Probe 
Spectrometer Setup control panel as shown below and Start Accumulation . 

If you are using a 2401 position computer then the dithered box 
should be unchecked. For a 2503 Memory Interface check the 
dithered box. This applies at aU times. 

Spectrometer Control Panel Acquisi\ion 1 ConrlgUlalion I Deleclo,\ifidlh I DAC I V1 CUlVes I 
Start Accumulation I -=~--.J--'-------"l ~Dall:I 

CenterBe 85

50

--=::::; Start Accum. JI-----ll BE readout j 
WindowWicith l 

NumberOfPoints 1(10 
Nscans I Nreads ,--__ ...,1 

Resolution 14 :::J 
Scanned W 

HorizLinearization r 
Dithered r 

Signature r 
Play Mode 

BindingEnelgy 278 

Resolution 14 .:j 
Vr 1042.068334 

V1 794.8 
Vr long Ox29b2b 
V1 long Ox7c30 

pass energy 166.5961771 

r Collect Data Read Once 

FilterCoefficient o 
Accessories 

",. ___ .. l(rllY IxR.tt~ . ,.,1 1:7 {\npra'p 

r Collect Data Read Once I 
FilterCoefficient 0 

Accessories 

Xray IXRay400 :::J W Operate 

AperturelNone 
FloodGun r 

lonG un r 
Inferlock W 

AccessoryMask OxO --------

.-

a CBE 
WW 

85 
50 

Nbr Pt 100 
Scans 1 
Res 4 
Scanned Checked 
X-Rays on - 600 spot 

=I=~_:-~~~~~=J:.==::c:j.::: 
J __ ..... _ ..... __ L ____ .-1. __ 

i ........ - ......... - ... ~-.... . 

••. _.--_.,._- -" 1 •.... __ .--j .. __ ............. - .. _ ._-

.... _-_._._._ ... _ ..... : ... _ .. _---
I l ....... ..... -.J--·---···- T'·------,··---

····--- ·--·-1-------·--·+-- ··---·---1---1·----· ··-+-

This will generate a spectrum of the Au 4f. With the cursor set at the center of the 7/2 
peak, read the BE at the upper right comer of the spectrum display, 
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Calibration and Set up - Establishing starting calibration values cont. 

3. Calculate the following: 
New PassEVRes4 = 166 + (measured peak position - 84). 
Enter the new pass energy into the configuration table and select Commit. 

4. Set up following unscanned spectrum 
a. Remove the check mark from the box titled "Scanned". 
b. Center BE = 85.8. 
c. Window Width = It will use the Detector Width. No input needed. 
d. Number of data points = It will use 128. No input needed. 
e. Number of Scans/Reads = 200 
f. Start Accumulation 
After spectrum is accumulated, use cursor to measure separation between the Au 
4f 5/2 and Au 4f 7/2 peaks. 

5. Calculate the following: 
New DetWidthRes4 = 19 * (3 .68/ measured peak separation). 
Enter new Detector Width into configuration table and select Corrunit. 

6. Make following entries: 
a. DetWidthRes2 = (DetWidthRes4) / 3 
b. DetWidthRes3 = (DetWidthRes2) * 2 
c. PassEVRes2 = (PassEVRes4) / 3 
d. PassEVRes3 = (PassEVRes2) * 2 

These starting values will now be used in the automatic program to refme the 
calibration. 
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Calibration and Set up - Run DAC to calibrate BE span. 

Acquisition I Configuration I DetectorWidth DAC 1 V1 Curves I 
Data 

o -----------------. ------------. -,- -. -. -. _. ----------------------. , 

o 

The DAC calibration is very simple. Align the copper sample under the microscope. 
Clean the sample with an Ion Etch. Then select start. The spectra will be displayed as 
they are collected. The display window will provide information as the calibration 
progresses. 

they are collected. The display window will provide information as the calibration 
progresses. 

The DAC calibration may fail to find the Cu 3s 1/2 peak in the preset window. Small 
errors in the DAC constant will cause large errors in the Cu 3s 112 peak location. You 
will need to provide an improved initial estimate of the DAC value. Run a 100 Ev wide 
scan centered at 120 Ev and a 50 Ev scan centered at 930 Ev. Find the centers of the Cu 
3s Y2 and Cu 2p 3/2 peaks using the cursor. Compute: 

((Cu 2p3/2 - Cu 3s1/2) energy separation 1810) * current DAC 

Enter this value of the DAC into the configuration table. Follow steps 1 through 3 above 
to re-establish the Au 4f7/2 line position to 84 Ev. Re-run the DAC calibration. 
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Calibration and Set up - DAC calibration - cont. 
The DAC calibration can leave the absolute binding energy far out of adjustment. It is 
only attempting to set the separation between the copper peaks to the correct value. 
Return to the acquisition tab and collect a scanned spectrum at the Au 4f peaks. Use the 
following setup: 

CBE 85 Res 2 
WW 30 Scans 2 
Nbr Pt 300 Scanned box checked 
X-Rays on - 600 spot 

24 

l 



Calibration and Set up - Detector Width Calibration 

Use the cW'sor to fmd the center BE for the Au 4f7/2 peak. Find the value of 
PassEVRes2 in the configuration table. Calculate: 

New PassEVRes2 = current PassEVRes2 + (measured peak position - 84). 

Enter the new value of the Pass Energy into the Configuration Table. Make the same 
calculation for Res 3 and Res 4 but use the Res2 value (measured peak position - 84). 
Enter these two values into the configuration table. Select Commit to record all three 
updated values to the registry. 

Select the Detector Width Tab. Set the run conditions for Res2, Res3 and Re4 as shown 
below. Select start. Watch the calibration proceed. If the calibration fails to find two 
peaks it is usually because the peaks are not well enough centered in the window. Make 
small changes to the pass energy as described in the paragraph above to center the peaks 
and try again. This calibration sets the absolute BE for all pass energies. 

Note: Increasing the pass energy moves the peaks to lower BE. 

Acquisition I Configuration DetectorWidth 1 DAC I V1 Curves I 

0 - - - --- -- - ----.------------ --

I 

. 
I -1--

q 
I 
I 

o 
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Calibration and Set up - VI curves 

This calibration is only needed if the V 1 supply is digitally controlled. The 
VI curves settings will have no effect on a model 8701 Spectrometer supply 
unless the supply has a digital VI upgrade. The optimum voltage setting 
information may be useful for manual adjustment of the supply. 

Acquisition I Configuration I DeteclOfWidlh I DAC V1 CUlves 1 
CountRate Res 'j low be III 0.00 eV 

0 VI End 
0 

Results 
Test BE Vrmax 

RES 1 Low BE 84.0 1370.5 
High BE W 1100.0 354.5 

RES 2 Low BE W 84.0 750.0 925.0 25.0 15.0 1343.3 
High BE 1100.0 200.0 350.0 10.0 15.0 327.3 

RES3 Low BE W 84.0 800.0 975.0 25.0 15.0 1289.1 
High BE W 1100.0 225.0 380.0 10.0 15.0 273.1 

RES 4 Low BE W 84.0 850.0 1100.0 25.0 1236.1 
Hi h BE W 1100.0 250.0 420.0 10.0 220.1 

Run Test 

Calculate RES 1 

Update registry I RES 2 
RES 3 
RES 4 

~alcUlate Ht:~ 1 U.4L :>::J.oo 

Update registry I RES2 0.44 84.02 
RES 3 0.49 142.72 
RES 4 0.55 226.86 

-- ---

The V I curve generator. 

The object of running V I curves is to obtain a set of parameters that optimize the lens 
throughput for all binding energies. The voltage (V I), that is used to focus the lens, is 
continuously increased over a range of voltages. As the VI voltage is changed the 
number of electron that reach the detector is changed. The goal is to set a start and end 
for the V I voltage ramp that produces a maximum detector signal away from either end. 
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Calibration and Set up - VI curves - cont. 

Each Resolution requires two VI curves. All curves are created using gold as the sample. 
The spot size setting does not affect the final Slope and Intercept values. It is best to run 
with larger spots to improve the signal to noise. 

The Check boxes, under the include column, control which curves will be run. The 
button labeled "Run Test" will start the data collection. After all pairs, that have been 
checked, are run use the calculate button to calculate the Slope and Offset parameters. 
These parameters are used in the software to compute the VI voltage as a function ofVO 
(retardation) voltage that will keep the lens focus optimized for all binding energies. 
Review the computed values. The slopes and intercepts should increase smoothly and the 
resolution number is increased. 

Finally select the update registry button to make the new values take effect. 
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Calibration and Set up - Signature correction 

Return to the main Capture program 

Select the Capture Settings dialog. 

~l L"~{~IIII""·(r:\ PIOIJ, .. "'III"''' f''''2000\'''''''''III,, •. mdb) __ ~ 

I Eile ~iew i Settings t:!elp E~it 
II D d ~.f Set System Registry Defaults 

ro' Recipe 
r Experime 

Edit Scofield Table 

Set up ESCA 

;:-; Pe'form~nce':test ~ 
7; Position T able Blank 

;-;; Sampte PlOiect 

lL I Are. Peak Ac 

on 

X·Rays I Spectrometer I 

r Signiture Correction ON 

Signature File Palh: !C:\Program File$\ESCI>. 2000\$ig.txt 

r Dither 

r HOIizontal Linerization 

1._ bdncel !Jpdale 

If the ESCA uses a Model 2401 Position computer then the Dither box should not be 
checked. Check the Dither box if a Model 2503 Memory Interface is used. 

Remove the checks from the Signature Correction box and h.Ori7ont:l1 lim~ri7::ltion hoy 
1I me t',;)L,f\ uses a Model L4U 1 PosItIOn computer then the Dither box should not be 
checked. Check the Dither box if a Model 2503 Memory Interface is used. 

Remove the checks from the Signature Correction box and horizontal linerization box. 

Enter the Signature File Path as shown above. This will stop the "Signature file not 
found." message that is shown when the program is started. 

Select update and close the dialog box. 

If you have a history of signatures in the C:\Program files\ESCA VB folder, the files can 
be moved to the C:\Program files\ESCA 2000 folder. These files will have the following 
endings: sig.txt.l, sig.txt.2, sig.txt.3 etc. Copy all files in this series. 
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Calibration and Set up - Signature correction cont. 

Place an Unscatmed Function in the MRS table. Set the CBE to SlOeV. Input the time as 
10:00 to set it to 10 minutes. Set the spot to 800 microns and the resolution to Res4. Use 
Default and Temp for the Project and Experiment. The collected data does not need to be 
saved. The computed signature file is saved. 

Select Run. 

~ '{lelY !jeIp SettIlgs ElQI 

DrHf 1iJ1 

, •• Defau!1 
!1J Temp 

Use. IAdmrisl.alOl 
Oere 

Un Scanned function 

GUS 

Select Run 

Save as Default and Temp 

P.oj N"'''IOelalEl 
E><PName:II::-Tem-p-------

Exp Desc: ldata 101 signature ca!cuL.!Jlion. 

Analy,is: IRaw dola 

After the data has been collected just leave it displayed. Then select the Setting > Create 
a new signature file menu. 

EIe ~- tit!<> I s.tl<lQs ~ 
I D r;l~.r 51 ) ~t Sy9.em Re>90~lry ~J HJ:~ 

C~e ereferenc~$ 

r R 
r.ElI~ 

~ I [DTemp 

rR 
r.E~ 

r ... · Defd 
11:1 Temp 

Edt ScolleidT_ 

SeluoE5O 

Set UO E50 

Create a Ile\Y S:gnatll'C Ie 

.,,'" 

Capture button converts the Temp 
spectra into a sig. txt file. 

Save the sig.txt file 

Save the sig.txt file 

85 90 95 100 105 110 115 120125 

Select the capture button. The signature will be computed from the data in the spectrum 
display window of the main program. The signature will be displayed in the signature 
window. 
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Calibration and Set up - Signature correction -cont. 

Select save to save the sig.txt file and back up the last sig.txt as sig.txt.l. All other sig 
files will be rolled to the next higher number. 

Close Signature conversion dialog. 

Re-Open the Capture Preferences dialog. Settings> Capture Preferences in main tool bar. 
Enter a check in the Signature Correction check box. 

I E!~ '!lew I Settlng~ !::!elp E;9t 

II D d ~[ Set System Registry Defaults 

(;. Recioe 
r Expefime 

Set up ESCA 

::;; Peflofman';-e test ~ 
;::; Position Table Blank 

::;; Sample Pfoject 

X-Rays Spectfometef 

Signiture Collection ON 

Signatllfe File Path: IC:\Pfogfam Fdes\ESCA 2000\sig.txt 

Dithef 

r HOfizonlal Linefization L Area I Peak I AL 

''"~ 
::: II 

300 
(f) __ _ 

bancel 

Set up and calibration is now complete. 
A (f) ___ I 

Set up and calibration is now complete. 
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Database Functions 

It is highly recommended that each user create a personal Data Base! 
Click on File> New> New Data Base IProtocol. 

New Data Base/Protocol 

Qpen 

Export 

~ ~ .?ove 

= Savee,s ... 

~i Get Categories/Aecipies 

Compact Qatabase 

Backup 

It!l Print 5 etup ... 

C9. Print 

d klose 

E~it 

C:\Program Files\ESCAVB\donald.mdb 

F 
C:\Program Files\ESCAVB\dak.MDB 

C:\Program F~es\ESCAVB\examples. mdb 

C:\Program Files\ESCAVB\dak.MDB 

~'I 400 

350 

300 I 
250 I 
200 I 
150 

100 I 
50 1 

1 

New Category 

New Recipe 

New DataBase/ t-'rotocal 

uick J Last Aunnin!l I 

~ I ~ td (J -

31 

I 

I 
I 

User IAdministrato 

II ~xperiment .... 
I 

ProiName: I 
Exp Name: I 
Exp Desc: I 

I A 

1 

~ I I 

SSP, 

1 

Last Aun Date: I 

I B I ... 
I 1 

-
.F 



Database Functions - Creating a new database 

Enter the new data base name then select Save. 

Savejn: 

File Dame: 

S ave a s !y 

I . --=:J E sc a v b 

.mdb 

~ e xamples. mdb 

~ Programdb.rndb 
~start.mdb 

I 0 pen a s !ead-only 

Enter Database name. 

2J~ 

3 §!j .ctJ rrn ~ 

r ~ave I 
Cancel' I 

The categories Depth Prome, Performance Test, Position Table Blank, and Sample 
Project will be automatically loaded with each new Data Base. 

;:; Depth Profile 
I;;: Performance test 
,,... Position Table Blank 

Sample Proiect 

I~ Sample Proiect 
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Database Functions - Get recipes from another database 

Recipes can be transferred from one Data Base to another. 
Go to File> Open > and select the Data Base into which Recipes are to be transferred. 

Now go to File > Get Categories/Recipes 

t;lEsca Capture (C:\Program File.,\ESCAV8\D 

II! _ile ~iew 
U [j [::lew 

r 
-------(riflI 

( 

Qpen 

Ex port 

2,ave 

t:!.elp Settings E~it 

· 
• A llf 
~ .: .. ~ 

Save 8.I
S

I"!· iii 
· • 
; 
· 
~ (Q) Print Setup" . 

• [Q. Print 

d ~Iose Get Categories/Recipes 

E~it 

C: \,Progr am Files\ESCAVB\DAK -new. mdb 

C: \Progr am Files\ESCAVB\Ko2. mdb 

r 
C: \Progr am Files\ESCAVB\DAK -ne'l>!. mdb 

C: \Progr am Files\ESCAVB\Ko2 . mdb 
--- ------' 

Highlight the Data Base that contains the Categories/Recipes to be transferred and click 
on Open. 

Highlight source 
Database. 

......lI ESCAVB 

~viewer 
~ v lewer2000 

~AQulck. rndb 
~' E'St:<WB 

Prograrndb.rndb 

File narne: 

Fifes 01 t'ype: 

~start.rndb 

I?JJ start. rndb 

IKoz.rndb 

I-·mdb Cancel 

I Open as read-onl.Y 
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Database Functions - Get Recipes from another database - cant. 

nDO NOT TRANSFER OR ALTER THE TEMPLATE DATA 
BASES, ESCA Template.mdb or Programdb.mdb!! 

In order to transfer a Category and/or the Recipes highlight the Category and hit the 
space bar (note that after highlighting a Category or Recipe, hitting the space bar toggles 
the (-), (+) signs in front of the titles). 
Highlight and hit the space bar once for each Category and Recipe that is to be 
transferred, then click on the Copy button. 
If a Category is showing a (+) and all Recipes below the category show (-) then all 
Recipes in the Category will be copied. This saves the effort of checking all Recipes. 

If a Recipe shows(+) but the Parent Category shows (-) the Recipe may 
not be copied. If the target database (the one you are coping to) has a 
matching Category then the marked Recipes will be copied. 

on 55 
. (+~,u on 55 

(-JPerformance 
(-)Position Table Blank 
(-)Sample Proiect 
(-)TEST 

(-)TEST 

Highlight a Category. 
Hit space bar. 

Highlight a Recipe (s) . 
Hit space bar. 

op!<, 

;< 
C.Encel 

Click on Copy button. 

[ Click on cop; buttO?] 
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Depth Profiles - Open the depth profile table generator. 

II EIo '{~.... t!<'\> Set."" ." 
~ D d ti rti . 

_ T~e Utme 

; IAuOtlSS 

Utet ~rtral.GI 
D .. c 

Spot Sae Elch flc;od Gt6l C~",*$ 

1 F~ 

o hPrd1e ... '00 
Au on SS ~ 

~ 1000015 ron--- r--
r r r r 

Rot~e St--t.6.s 0elalJl l 
~ \-----,--, 

END 

f'l oj 11""" I. 
E>:PNMI': i-lt \.l'Ve)'---OfOl-c,-c ... ----­

bP'Dc~ lfhollS'CNI 
A",,,;", Ij,;-A ... --doI:':-:--' - ----

T 
1. 

Soon VISi:oIe XoII$el YotfU:1 YSc6~ 

A~ame CSE Scanned? .WI Scanl f'l1S RMn 
• Au41 8' r 0' 0000 

o 0 
o 0 A, 

Clo 194 r 00000 • 
o It 530 r 0 00.00 I .. 

F. n r: 0 OOOD • 

f l<le . V' I04' .u.n, 110 Co 3. G. 30 G. 3pJ H,4f5 Fb 5p1 Po5p3 Pl 51 Sb.p Si 2p 11501 ! 
tj!St . .. 1 rtl lJ ~ I I!!JD ... ",,,,,,·.k>o·do< ·,,,,,· .. 1 !:l E''''C''''~.(D' \ESCA 2 ·· ·1 

1. Select the Depth Profile function from the function list. 
2. We suggest that the first Template be a default Template. Use this as a 

temporary table. It is rare you will reuse a Depth Profile. Continue to step 4 
if you are going to write over the default template. 

3. If a reusable template is desired then select New. Edit the Template Name. 
L.. we suggesr mar (ne lUSl 1 emptC:1le ue C:1 UelC:1Ull 1 CJUpHIlC. U::;C UB::; a::; a 

temporary table. It is rare you will reuse a Depth Profile. Continue to step 4 
if you are going to write over the default template. 

3. If a reusable template is desired then select New. Edit the Template Name. 
Go onto next step to define the spectrum regions. 

4. Use the Add and Delete buttons to create a table of Region Definitions 
a. Region name is typically the element symbol and transition label. When 

this convention is used, the data reduction will automatically identify the 
transition and look up the Scofield cross-section. 

b. CBE - Center binding energy 
c. Scanned - checked WW (window width) must be entered with a non 0 

value. Scans is number of scans. If a time is entered as hh:mrn:ss, then a 
number of scans will be calculated, but not shown, that equals or exceeds 
the time. A default e V /step will be offered. 
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Depth Profiles - Cont. 

d. Scanned -not cbecked. WW defaults to detector width, Scans/Time is 
collection time and can be entered as seconds or hh:mm:ss and fmally 
eV/step is not required. 

e. You need to enter a Resolution number in all cases. 
f. Hh:mm:ss can be entered as b:mm:ss, mm:ss or m:ss. 

5. Set up the Spot Size, Etch Time in seconds or hh:mm:ss, Flood gun state and 
Nwnber of Etcb cycles. 

6. The Rotation can be "On" or "Off'. If rotation is "On" then tbe sample holder 
will rotate an integer nwnber of rotations during each etch cycle. 

7. Select Paste to Save the Table and Close the Depth Profile Dialog. 
8. Use the ESCA Control Panel to set up and test the sample al1gnment, and ion 

gun operation. 
9. When ready select any of the Run Buttons. 
10. Tbe Spectrum Viewer will display the Deptb Profile during tbe etch cycle. 
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ESCA Control Panel 

Previous versions of the software used A Quick as a simplified control panel. This 
update replaces A Quick with the ESCA Control Panel. 

The first row of the panel presents check boxes allowing for the activation of the FI~ 
Gun (charge neutralization), Ion Gun, X-ray Gun and, if applicable, Aperture. 
Changes in these parameters take effect when the boxes are clicked. 

The second row and third row are grouped together in a frame. The fields represented in 
the frame directly control the spectrometer. The Panel is shown with the scan variable 
not checked. This is the UNSCANNED mode. The active variables are (CBE), Spot 
size, spectrometer Resolution, and Capture T (time in seconds). Changes in these 
parameters take effect when the st31i button is clicked. 

ESCA Control Panel- Unscanned mode 

on/offtoggles for 
Flood Gun, Ion 

Gun, 
X-ray Gun 

pull-down 
menu for 
Aperture 

o 

CBE 

- Ion 
I Gun 

r.;; X·ray Gun 
Operate 

Spot size Resolution Capture T 

r Scans V.Jindow ev/ step T 

Exit 

o 
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windows for 
CBE, 
and 

Capture T 

pull-down 
menus for 
Spot size, 

and 
Resolution 

0 ,0 

I, 
0 ,0 

ESCA Control 
Panel 

spectrum viewer 



ESCA Control Panel - Scanned Mode 

Placing a check in the Scans box provides access to Scans number, Window width, 
eV/step, and Time/step. 

Scans box 
activated 

I E:'] 

Spectrometer Controles 

I" Flood I" Ion 
Gun Gun 

Aperture 
W X-ray Gun JNone ; I 

Operate ~ 

CBE Spot size Resolution Scan Time 

285 1800 iJ 13 ~I 0:00:17 

w Scans Window ev/step Time/step 

20 .2 1100 3 

Exit 

o 

, 
o 

o 

r s,,"~ J 
windows for 

Scans, 
Window Width 

and eV/Step 

pull-down 
menu for 

Time / Step in 
Milliseconds 

The scanned mode is especially useful for establishing the center binding energies of 
those elements of interest for High Resolution Spectroscopy and also for establishing 
optimum flood gun parameters. 

Note that, while in the scanned mode, the Scan Time field is shaded blue. 
This indicates that the Scan Time field is a Read-Only field as it is a variable dependent 
on the other scan parameters. 
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ESCA Control Panel - Quick survey. 

Place a check in the Scans box, type 500 or 550 into the CBE box and 1000 or 1100 
respectively in the Window box. 
Set Time/step to 50 and click on START. 
Note: The overhead time per step is 25 milliseconds. This is not included in the Scan 
time calculation. 

II Eile I l,I.iew tielp Settings E~it 
I e:J .! ../ Big Status Display =~===:::::========, 

( Data Reduction 

See Big Display at 
bottom of Panel. 

Iv ESCA Control' Pnl 
X·rayGun I Motion Control Pnl Operate 

Scan List 

CBE Spot size Resolution 

Aperture 

INone :.:1 

Scan Time 

I Append CO Over Write 

Run Ito" 

One "~ 

El)d r." 

I 285 1800 :.:1 13 :.:11 0:00:17 1[ "'-1 
~ Scans Window ev/step Time/step 

J 1 I 20 I .2 1100 ~ Current Count Rate 

I~TART'I~ .----==-J [''"""] 
0,0 

o .... - -- .-. ---.. -~-~- _ .... -.--

o 

Text 1 

. . 

Very large display of 
Count Rate. 

This display can be expanded and moved. 
Additional status parameters are then 
displayed . Available during normal capture. 
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Calibrating the Microscope for Correct Sample Registration 

Place a phosphor sample on a flat stage and transfer it to the UHV chamber. 
Use the joystick to manipulate it to the vicinity of the registration point. 
Turn on the Flood Gun, and X-rays. 
Set the CBE for O(1s) at~S32 eV. 
Choose the largest Spot size, Resolution 4, and a large number for Capture T 
(3000seconds?) . 
While monitoring the counts adjust the Z-axis of the stage for maximum counts. 
Also, insure that the "dot pattern" on the CRT is centered (side-to-side). 

NOW, UNTIL THE MICROSCOPE HAS BEEN CALlBRA TED, DO NOT USE 
THE JOY STICK OR DO ANY OTHER MANIPULATIONS TO THE STAGE. 

Turn off the flood gun (the flood gun emission may make the area irradiated by the 
X-rays difficult to see). 

Use the SOX magnification and the eyepiece cross hairs, adjust the Z-axis of the 
microscope so that the irradiated area of the phosphor is in focus. 
Now use the microscope's X and Y-axes controls to move the eyepiece crosshairs to the 
center of the in-focus irradiated area on the phosphor. 

If a small Spot size is to be used change the Spot size settings to the appropriate size and 
recheck the crosshair alignment using the microscope X and Y-axes adjustments. 

The microscope is now calibrated. 

Now use only the joystick controls to bring samples into focus and areas of interest under 
the eyepiece crosshairs. 
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Experiment Names as part of the database structure 

The Project and Experiment Names are displayed in a number of places in the program. 
The two names together form a unique identity for a MRS, Depth profile or one position 
in a position table. Examples of the tree structures that help to find your data are shown 
below. 

r Recipe 
r. Experiment IDefault 

.f, Iron from 55 
Multi scan Au 

Multiscan 55 ~ . 
Phospher 2 Expenment Name 
Phospher 3 

·t, 55 Chrome and Iron 
't, survey for test 

;::; A Quickie 
;; b 
;;; test 

Proi Name:la 

Exp Name:lsurve}' for test 

Exp Desc: Ishort scan 

Anal},sis: IRaw data 

Current Source FilejD:\ESCA 2000 G\examples.mdb 

B.ehesh I I I,;ld [I jl.j I A.dd Dell." 

. Experiment: Iron from SS 
ft' 'E xperiment: Multi scan Au 
E ,Experiment: Multi scan SS 
~ Experiment: Phospher 2 
::i:l Experiment: Phospher 3 
;' Experiment: Multi scan Au 
~ , Experiment: tviulti scan SS 
F!:l ' Experiment: Phospher 2 
, Experiment: Phospher 3 
, . Experiment: SS Chrome and Iron 

Experiment Name - Name 
entry box. 

Data Analysis Program -
Experiment tree . 

] 

Original Raw Data 
' .. ' . Experiment: survvEe~Y~fo~r~te:s:t ::============:::=r=====---~=-----------------~ 

r- Raw Data -
'H S urvey(. ·600. eV, 1500 pIs) 
.... C 1 $(271. ·292.8 eV, 124 

DR1 
Hi Prnip.r.t'A illJir.kip. 

Set of Reduced Data 

Data Analysis keeps Reduced data with Raw Data for ease of recovely. Raw data is 
never presented for manipulation. Only a copy is presented in the Spectrum Viewer. 

41 



Graphics controls - Chart editor 

I Plot Name:'.---------. 

frill",,) 6E1 
I~~IJI Selies 1 

Selies 1 6."el.1 Axis I Till.s 1 Legend 1 Panel 'I Paging 1 Walls l 3D 

~ ~howAxi, 5 cal6S I TlIe I Labef< 1 Ticks I Moml 1 P",~ion 1 

~s~eHl '" ~l~omalic 

r I" I Maxiroom: 2.521 
r Bigh! 

l C<~ 
l- II 11 Min:nlum: 1 .. , r ~oUom 

r Qeplh 
l::hange, I Des'ed Incremen!: 1 

r Logal.hmic r jnvelled 

'" ~~ibIe 

Zoom 

~_1.. ~ 
Rotation 

~~ B 
Elevalio.!) 

~ ~ B 
Pelspective 

~lI ' ,~ 

Qone I 
250 !:ielp .. , Close 

The chart editor provides control over all aspects of the Graphic presentation of the 
spectra. In the following sequence of screens we will show some of the typical controls. 

The X and Y axis presentation is controlled on the Axis> Scales page. The "Axis" 
column in the left frame controls the focus of the "Axis" sub pages. 

IJIi< 

1.601< 

1.4K 

12>< 

1K 

200 

ytodlh: r ~ Cholt 1 Seri .. ] 

~I SOlie> ] G.,."aI Am 1 1<1,,, ] Legond] P ..... t ] Pag'ng] Wa'ls ] 30 

P' ~hoVl Axis Sc.:lss l r~ 

A.~ 

Color .. , 

D 
Co' ~elt 

Select Ticks page 

... 

~....s..~"""'--'-r"I ~ Click Grid Borders Remove Visible check 

I 

~_---,I Len: ~ ~ '" At Labels On:~ 

tnroe<, I Len: ro-- :;;;l 

Click Grid Borders l!)r"" I Len: ro--~ 
Remove Visible check 

Do.€" 

S50 SOJ 450 400 

Removing grid lines for X axis. The axis control was changed to Bottom to remove the 
vertical grid lines in the next screen. 
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Graphics controls - Chart Editor -cont. 

2.4K 

2~ 

2K 

L6K 

1.61< 
1.4K 

1~ 

lK 

aoo 
600 

400 

200 

2.4K 

2.21( 

21( 

UK 
1.6K 

1.4K 

1.21< 

11( 

2.4K 

22K 

2K 

1.61< 

1.61( 

1.4K 

12K 

lK 

. ¥~ 

I 
~!l4e: 

r Sold 

r Oa,h 

Ii' 001 

£01<:< ... 

D 

Selie, 1 Gene,'" A#; I TitJe.o 1 Legend 1 Pa ... el 1 P~ I Wah 1 :II 
W .:ihowA .. , Sc;/.,I T;Je I Label, Tick, I Moo I Po,~on I 

I 
r O.,hOol 0" I rr _I.R~ 
r O., h 0 0/001" ". 

r 5,..1001, I Cancel r lop 

--r------=~===::::.._J..J. Ii' ~oIlom 
l r 12e¢l 

Ticks .. I L." r::J W AI Lobel, 0 .... , 

l!ofIet.. . I len.: ro-~ 

Bottom Axis selected 

'----------------r~~'~ Help Ciole 

$SO 500 4SO 400 350 300 250 200 1 so 100 

-I 

I ~ Irfdilul HEf 
CI;"I 1 5 ..... 1 

Se,ia, I Ge .. "aJ AAS I TOle, I Legend I p-I p.gngl Wal' I 3D 

Titles added 

500/'" rll_ I Labeb I Tick, I Moo I Position I 

I--,.,.~!'"""..,..-t~ Tjlle: IBINOING ENERGY· e>.1 

• Boliom 

I r Qeplh 

~~==~======~~~I 
L-----------~.r---------------- lielp. · Clo .. 

200 150 
BN):NO Ef'.EROY . eV 

J -

lufu, 6 
BAsic CO~OI $: 

Chell I Series I 
S ..... I Ge=atl A.<i, I HJ .. I Legerd Panel I P;9ng I We" I D 

aeVel!nner. j [ Bev~Quter. 
r. None r None 

I r loweled r Loweled 

r Q=-<".M r. R.=:W ... ri 

s ..... I Gene<atl A.<i, I T,Jes I Legend Panel I P<9ng I Wet, I D 

eevel!nner l r Be~Qu(er: 
r. None r None 

I 
r Loweled r LOY.'efed 

r Raised Ii' Raised 

' G,aderl-

Custom Co/OIS: I 8&;k 1rM.ge I. y.oo:e D ____ ---' 
••• • • • Set Panel Color to White 

oor., 

550 500 450 400 350 300 250 200 150 
I3:>IONG ENERGY· eV 
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Graphic Controls - User Preferences 

2.51{ 

2J{ 

~ 1.5K · 

z 
:::J 
o 
u 11{ 

500 

User preferences Icon 

400 300 200 
BINDING ENERGY - eV 

~ 1 ~ 1 1i 
Chait I Selies I 

'I 

Left A,is G,id Inclement 1500 
SoUomA,is G,id Incl.menlr:-llO""O---

r;; Show whole l)urOOefs fOf X oyjs 
~ Speclrum alignment 

• I 

~ ... - . Area I Peak I Auto [ind I lools A I ' 
- I Examp Ie of Title I 

Selies I Genelall Axis Hies I Legend I Panel I Paging I Wall, I 3D 

25K · Title or Footer 

2K 

(f) 1.51{ . 
I-
Z 
:::J 
0 
u 11{ 

500 400 

Sacls Colol.. . 

l 
300 tlelp ... 

!lordel ... 
r Left I 

[

fignmenl 

t r bent• , 

___ Pa_lte_'r_I...--,! r. Bight 

Close 
BINDINGENERG~_--=====-______ ~ ___ --=====-....J 

_ _____________________ FOOC:.canbe flgll" IlUnber J '-_______ _ 
The above sequence shows a few of the capabilities of the Graphic Editor. Many Fonts, 
font sizes and colors are available. Legends can be created for Graphics with overlays. 
The panel background can have be a blend of two colors. An depth profiles can be 
displayed in 3D. 
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Graphic Control - Print Utility 

The General Page of the Graphic Editor provides access to a Print Utility and Graphic 
Export. 

FOimat 

r. as llitmap (8MP) 

r as Melafile [WMFI 

r as Enhanced Melalife [EMFI 

r as ".lEE lae (TEE) 

r as 4PEG ~PG) 

:::l 
o 
u 1K 

Clase 

Chari ] SeriO'. I 
Series General] Axi, I Bles I Legend I Panel I Paging I Waif. iI' 3D 

Zoam 
Print Ereview ... 

'" eliol'lZaom 

,- Animaled ZQom 

'" (;lipPainls 
~ leps: rs-- jJ 

I Mar~m(~) 1 'AHa", sCIOn: 

[O...o..J r Nane 
...o..J r !::!orizonlal 

lrjJ rjJ r ~erlical 
~...o..J ...o..J r. llolh 

500 400 300 !::!elp ... Close 
BINDING ENERG\· __ =====-______ --,-.-___ --=====--.J 

FOOIer ce.n be [rowe ~ ~ 
p----=-=-=-~~==========~=========--- ~~-----------

! ~ I J'Jea i peak ] 

I Examp le of Tt 

2.SK 

2!{-

(j) 1.SK 
>--z 
:::l 
0 
u 11{ 

SOO 

11\ 

soo 

P!inter: I HP DeslWe\ 1120C 

-~aper Orienl.lian:l- ---I 
r PQllra~ 

(0 Landscape 

H .!11 

'" ~ieVJ Margins 

I Delail 

fl 

'" ~iew Margins 

Delail 

More 

I~ 
Normal I 

I Exo"!'io.f nt14 1 

2J5K 

1K 

~ InK 

=> 
o 
" rK 

o 

" 

100 
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Graphic Control - Print Utility - Cont 

The Print Preview can be obtained from the Printer Icon or from inside the Chart Editor. 
The Chart Editor provides more flexability. The Printer Icon provides convience. 

0>< 

2.51< 

1.51< 

lK 

soo .00 

eV:t32. . eou..-,h:: 178 

Example of printout form Graphics Editor 

Example of Title 

2.5K · 

2K 

(/) 1.5K 
I-
z 
:::l 
0 
(,) 1 K-

U) I.Ot\ 
I-
Z 
:::l 
0 
(,) 

500 

, , , , 
500 400 300 200 o 

BINDING ENERGY - eV 

Footer can be figure NurTtler 
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Graphic Control - Spectrum color 

The color wheel icon provides access to the "Cbange Color and Line Style" dialog. 

2.5K '. , , , 
, , 

21< '. , <-
1 .5K , 

, 
, 

Graphic Control - Clipboard 

2K 

Clipboard Icon 

1.5K 

1 .5K 

~I~--v-/ 
i 

295 290 280 

Line Slyle 

<- Solid 
, Dashed 

' Dol 
' Dash Dol 
, Oash Dol Dol 
, Clear 
, Inside Frame 

Qose II [~:~il~] 1 

o 

- r 

I 

-- e ~ d 
275 270 

The spech-wn displayed in the Graphics Viewer can be placed on the Windows Clipboard 
by clicking on the Clipboard leon. The image is available for pasting into any Windows 
program. 
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Motion Control-Angle Resolve and tilt stage setup 

1. Load Motion Control Pnl 

2. Load Position Table 

r Append r. 

Function 
PT M 
Default 

Run o!." 

One_" ]! 

End .-::-" 

The tilt stage can be loaded with (he support be 
the left or right. Your choice usuall}. depends on th 
gun position. Select. a "Support Side". 

Choose Support Side 

r Support on Lelt 

r. Support on Right 

The take·off angle is measured between the axis of the 
lens and a sample reference. The surface normal~ or the 
plane of the surface can be used as the surface 
reference. Select a method of defining the take·off angle. 

r Angle between lens axis and sample normal. 

[

efine T ake·off Angle 

r. ~~Q!i. .. ~.;;.i~i.i.~.·.i;;.n.:s. .~.x.i~::~~~:s:~~p'ii.:.s.~·il~~~:'] 

r Angle between lens axis and sample normal. 

r. ~n9ie··bet~een·iens axis a.nd sample surface 

OK Cancel 

I 

Motion Controls 

Configure I E:::I,~r II 
__ M_ot_o_rs--, ___ ----' ;-_--'---' I ~ i 

Molors Ii 

J_I] 

.clear Qel Save> J;.xit I 
T able Name I Default 

r Recipes Joy,tk ~lep eMb¥J 

Add Line I Del Line I Move Up II Move Down , 

- 00 Line -r -uel Line - r Move up - I MOV" If<lWtf I 

R I~ 0.00 
15.00 

X 
1 0.00 
2 0.00 0.00 

I X I Y II z I R I .. 

I~ 0.00 0.00 000 0.00_ 
2 0.00 0.00 0.00 15.00 13 0.00 0.00 0.00 30.00 14 0.00 0.00 000 60.'00 

IS- 0.00 0.00 000 90.00 ... 

The tilt stage allows for computer controlled variable takeoff angle (TOA) analysis. 
With the Motion Control Panel open select the PT M function and open the Position 
Table dialog. This will enable the "Angle Setup" button on the Motion Control Panel. 
Click the "Angle Setup" button on the Motion Control panel to display the Tilt Setup 
dialog. 
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Motion Control-Angle Resolve and tilt stage setup - cont. 

The relations ships described in the Tilt Setup are pictured below. 

Takeoff Angle 

Lens axis 

Sample normal 

Tilt Stage 

TOA - Surface to 
Lens Axis - as 
shown in example. 

Sample surface 

Shown with bearing support on right. 

slot in machined 
aperture plate 
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Motion Control-Angle Resolve and tilt stage setup - cont. 

The tilt stage allows for variable TOA analysis and by rotating the stage about its X-axis . 
The TOA can be varied from ° to 90 degrees. Mount the sample by placing it between 
the solid bottom platen and the machined aperture plate. 

In order for the software to work properly the following conditions must be met; 
The microscope must be calibrated (refer to the section Adjusting the Microscope for 
Correct Sample Registration on page #17). 

Place the sample/stage in the preparation chamber so that the bearing support is located 
on either the left or right side of the stage. 

Lower the Z-axis to the minimum position before transferring the tilt stage to the 
UHV chamber. This is a precautionary step to avoid collisions of the tilt stage with 
the hardware that protrude into the analytical chamber (i.e. flood gun, lens, ion 
gun). 

Raise and manipulate the stage and superimpose the microscope eyepiece cross hairs on 
the grid line of the stage. 
This correctly aligns the tilt stage with the X-ray beam and the lens and the R controller 
will now tilt the stage. 

In this example a TOA of 35° (sample surface horizontal or flat) will be initially defined 
as home (0, 0, 0, 0). An approximate setting of the horizontal is sufficient for this initial 
setting. 

a Using the unscanned data acquisition mode and a strong elemental line adjust the 
Z-axis for maximum counts and click on the SET XYZ Home(see next page). 

b Now use the Y-axis to move away from the tilt axis (do not move Z). 
If the counts and signal (dot pattern on the detector) remains constant, then the 
stage is positioned correctly at TAO of35°(or 55° ifusing the lens axis to sample 
normal as the definition of TOA). If not use R (low speed) and adjust the tilt for 
maximum counts and click on SET R. This accurately sets the horizontal plane 

c Use GO TO home XYZ to return to the tilt axis. Check and refme the alignment 
of the grid line on the top machined plate so that t't overland~ the mir,ro"r,onp. ,r.ro"" 
normafas me aeIlnltlOn ot TOA). it not use R ( ow spee I) and adjust the tIlt for 
maximum counts and click on SET R. This accurately sets the horizontal plane 

c Use GO TO home XYZ to return to the tilt axis. Check and refme the alignment 
of the grid line on the top machined plate so that it overlaps the microscope cross 
hair. 
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Motion Control-Angle Resolve and tilt stage setup - cont. 

slot in machined 
aperture plate 

Aligning Sample for Angle Resolve Analysis 

Use Z-axis controller 
to align center of 

sample. 
Click SET XYZ ... 

Use the Y-axis andlor 
R to align an area 
away from center. 

Click SET R. 

Note angles entered in the R column in the position table on page 42. Enter the set of 
angles you plan to use in the experiment. Use the add line, delete line etc to organize the 
table as you choose. 

The steps completed to this point are: 

1. Select the tile configuration in the Tilt Setup dialog. Close dialog 
2. Align the Home condition for the tilt stage as outlined above. 
3. With the Motion Control Panel Measurement System set to degrees enter the 

tilt angles for your experiment. 

Now Select the Tilt Measurement System (see pg 42) in the Motion Control Panel. Your 
input numbers will be converted to Raw motor steps. This conversion will account for 
the tilt stage gear ratio and the Tilt Setup configuration. The fmal table is displayed 
below. 

~ 

the tilt stage gear ratio and the Tilt Setup configuration. The final table is displayed 
below. 
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Motion Control-Angle Resolve and tilt stage setup - cont. 

Select tilt measurement 
system. 

New blear Qel 

Table Name Default 

r Modes - ---

r Eositions r. Becipes Jo}' !f 

I XYZlmm 

II X:-3.39 

I 

Save> [xit 'I 

tep enabled I 

["';w' ~l 
Add Line 

1 _. 0 Deg 
2 15 Deg 

" 30 Deg .J 

4 60 Deg 
5 90 Deg 

:::oJ Rotation I tilt iJ J 
I'::;Y:::;::~-O;:;;.6;';3::--;:1 ::;Z;:;;:O;:;;.5~2- R:66~-

I I 
----

Select Recipe Mode 

0.00 
0.00 

0.00 0.00 
0.00 0.00 

The Recipes are assigned by selecting the Recipe Display Mode and selecting the 
Recipes from the dropdown dialog. 

The Recipes are assigned by selecting the Recipe Display Mode and selecting the 
Recipes from the dropdown dialog. 
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Motion Control- EnablelDisable Buttons 

Motion Controls 

I- ,·, r,liqur 
H JIO I 

l
Home Controles 
Joytk home enabled 

SET ',._ ' R , 

GO TO ", - , F: , 

--- --

r 

Enable 
!'·.! ,gl., 

.e.t1 Ir' PANIC I 
Rotation~~ 

I u" , 1 

Stop, ~ 

[

Units 

XYZ I, II " 

II X:9_76 

1 10 

iJ R-ot-ah-'on-I-,j"'-J-~ J 
~:::;:;:::... 

1 Y:2_3 1 Z:O_52 1 

1 1 1'--

Review the last three screens that show the Motion Control Panel. Notice the Motors and 
Joystick buttons take on the colors Red, Yellow and Green depending on the state of the 
Motion control system. Clicking either button will toggle the state of the Motors or the 
Joystick between enabled and disabled (Green or Red). 

1. Disabling the Motors turn the power to the motors off. 
2. Disabling the Joystick block Joystick control of the motors. 

The yellow state is displayed during computer-controlled movement. Notice that a 
number of control panel buttons are disabled during computer-controlled motion. 

NOTE: If the motion system stops working it is often sufficient to Disable the Motors 
and then re-enable them to restore normal operation. Your Home position will not be 
lost. 

Motion Control- Home controls 
C.n. - , ") 

Motion Control- Home controls 

Set current (x,y,z) 
position to (0,0,0) 

Moves stage to 
(x,Y,z) = (0,0,0) 

r Home Contloles '­
-,..._ ~"",\I.stk home enabled 

SET XY.Z R 

Set current (r) 
position to (0) 

GOTO ~~ _~R~~~~~~=:~~ 
L-- Moves rotation 

to(r)=(O) 

The GOTO R button causes the rotation position to return to ° deg or 360 deg. 
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Motion Control-Mode control of the Joystick buttons (6K4). 

Configure 
Motors 

Home Controles- -
---..-----. 

SET XYZ R 

GOTO X,(Z R 

Configwe Jo.ystick 
Motors buttons 

Home Controles 
JO}lstk horne enab"~d 

SET XYZ I R 

GOTO XYZ I R 
I I 
I 

Clicking the "Joystick buttons" button toggles the function of the two front buttons on the 
Joystick. When the Joystick home is enabled, then the left front button set the current 
XYZ position as home. Likewise, the right front button will set the current rotation 
position as home. This is very convenient for initially setting a home position while 
observing the sample with the microscope. 

Later, when reviewing the learned sample positions, the mode can be switched. When 
the home function is disabled in the Motion Control Panel then the Joystick Step Next! 
Step Back Function is enabled in the Position Table. 
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JOYSTICK CONTROL BOX - USB model 

Joystick 

[~~Y~Z~ __________ ~s~e~tH~o~m~e~ _________ R~ ] 
Back Step Position Next ------

The joystick controls motion along the X (leftJright), Y (forwardlback) and "Z axes (press 
center button while moving the Joystick forward-back). Rotation is obtained by twisting 
the outer ring clockwise/counter clockwise. 

The Get function "Gets" the current coordinates and fills or updates in the position cell 
in the position table. 
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Motion Control- Panic Button 

The PANIC button is used to immediately stop aU motion! 

E:j ~~ 
Motion Controls 

I 

Enable 
Configure Joystick .6.ngle 

I P.6.NIC I Motors buttons S, tup 

Home Controles - -- Rotation 
,JO}' tk home endbled Motors I 
SET XY2 I R Cont 

Joystick I GOTO XiZ I R Stop 

[_u:; 3] Goto x I 
Imm ::J Rotation Ideg or Get 

t I X:-O.34 I Y:2.3 I Z:O.52 I A:39 
I I I I 

----

All motion is stopped and power is removed from the motors. The current home location 
is not lost. 

To restore normal operation select the Motor button and then the Joystick button. After 
both buttons tum green, the Motion system will be ready for operation 
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Motion Control - Position Table Setup 

Setting up the Position Table disables Recipes so, when possible, compose Recipes 
beforehand. 

Use the Function pull down menu and select PT M. Then click the design button ("The 
Pencil") Icon. This activates the Position Table - Multi Recipe Panel. If the Motion 
Control Panel is not open it will be opened along with the Position Table. 

fiIo \lOW ~ Set_ f,. 
[) dt~ '" 
C4!mvt'. ~tllT" 

111122 
(i'Req,e 
r ENpf'l ir~ 

PT M Function 

400< 

Aec' PO$Itilm 

., 

S~voy 
AetHi 
HiS"" 
UnS~ 

D ..... "'o/i. 
IOSytl.em 
Etch 
N.ww., 
loki 
Bl 

Position Table -
Multi Recipe Panel 

1.2 

! 

Mohon Conllch 

SEI :«z I~ 
GOlD 2£J~ 

___ "O':U"...IJIla'--'.'-'-'1,,~"""'~. ~ I ~"t;°,, · 1 

Design Icon 
"The Pencil" 

-z:o- ~~ I 

3r-3 

~ tJelll (lei I Save>,E>i,1 

IoI>, N.". ID".... ::1 
Mcxi-..s. 
(. Eo' ior.; ("" B~-~ 

x y z 
0.00 0.00 000 no· 

100< ~.. i 
sa< ~: I 

1000 950 SO) 6SO 6CO 750 700 650 600 550 500 450 400 ~ 300 250 200 150 100 50 ~ 
- -

,.J/:_"i:.59_.Ux.n:l"S7007 181 31 Eu4p3 Pm4pl F\a 51 Re4d5 SeG Tc3d Tc3d3 Tc 3d5 W4d3 

Ii!l"". ",_.doc- Hc-··lle! "'0 (",,, .. (C,\P"'9_ <:l MOIIOflC,d,,,,,, I e! _ ,otle -","0""", 1 9:il PJrt 

I 1000 95D 900 050 600 750 100 650 600 550 sao .50 400 "'" 900 250 200 100 100 50 0 I ~ 
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Set Home 

Go to the microscope and set the cross hair on the axis of rotation. Go to the SET row of 
the MOTION Controls Panel and click on XYZ. 

Move toward the edge of the holder, preferably the fust sample. SET this position as 
Home for R. An initial reference co-ordinate system is now set that can be reproduced if 
there is a glitch. 
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Motion Control - Position Table Setup cont. 

Learning Positions 

There are two modes of adding rows to the position table. They are controlled by the 
radio buttons in the Get Current Positions frame. 

1. Select the Update mode. Each time the Add Line button, on the position table 
fOlm is clicked, a blank row win be added to the table. When the Get POS\\\Ot;l 
button is clicked the values for each axis will be updated. 

2. Select the Auto Add mode. Rows are added and filled in each time the Get 
Position button is selected. 

The Update mode is convenient for updating or refining the coordinates for an existing 
table. The Auto Add mode is best when building a table from scratch. 

NOTE: The Joystick Get Position button works the same as the button on the form. 
With Auto Add selected, you can learn aU your positions without going back to the 
computer. 

Choose one of the above modes of operation. Put the cursor on the X axis cell of the first 
row. Row (1). The X axis cell is arbitrary but a good practice. With the stage aligned on 
position, (Pos 1) click the Get Position button on the Joystick or on the Position table 
form. The Special Function button is the Get Position button for the old Joystick. If you 
chose the Update mode the coordinate cells of row (1) will be filled. If you chose the 
Auto Add mode then you will have a new row at the bottom of the table with the values 
for the current position. 

In the update mode, you will continue to put the cursor on the X column of the row that 
matches your sample. You will move to a new position and select the Get Position 
button. 

In the Auto Add mode you will continue moving to new positions and selecting the Get 
Position button. When you are finished , delete any rows left over from previous tables. 
Vnll ul,II thpn hp Ip-A- ",ith a t #3 hlo TU"I""\"t"'!oorl"" "" .... ...,.... ........... ......... ,.1 

In the Auto Add mode you will continue moving to new positions and selecting the Get 
Position button. When you are finished, delete any rows left over from previous tables. 
You will then be left with a table properly numbered . 

The screen on the next page shows the controls discussed. 
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Motion Control - Position Table Setup cont. 

E:I I _ ID I~ 
Motion Controls 

Velocity IE:::c I Setup 

SET XYZ, r Home Controles Rotation 

SETR Goto or 

I SET 
XYZI R 

I I Cont 

~ Get 
GOlD XYZI R I Stop 

r Units 

L XYZ Imm 

II I x:o 

3 .:;::;;:R=ot=at_io--;:n =1 d"""",e=-g.",--3~T I _ _ _ 
~ i 3: z:o ~ i·~l 

Positions 
toggle 

Update 
toggle 

I 

Name the new 
position table 
or pull down 
stored table 

Get 
Position 

NOTE: With the GPIB/2100 Indexer system the Joystick operation is not connected 
to the computer. Continuous polling of the Indexers to see if there has been Joystick 
activity leads to less reliable operation. The "Goto or Get" button on the Motion 
Control Panel is used to request current stage position. This provides the required 
.... ",'lot.. Th .. Motion rontrol P<;Inpl hutton ONI,V nnelates the MoHon Control 
to the computer. Continuous polling of the Indexers to see if there has been Joystick 
activity leads to less reliable operation. The "Goto or Get" button on the Motion 
Control Panel is used to request current stage position. This provides the required 
update. The Motion Control Panel button ONLY updates the Motion Control 
display. The Get Position Button on the Position Table and the Joystick update 
both the Motion Control Panel and the Position Table. 
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Motion Control - Position Table Setup cont. 

After the desired positions have been entered into the Position Table click on the Recipe 
button. This expands the Position Table - Multi Recipe Panel so that Recipes may be 
assigned for each position. 

Save the table and Run the analysis. 

l~Po§ltlOn Table - Multi Recipe Save. 

Table Name I Default 

~ . 11/22:Au 
....:::=~ Beclpes 11/22:Phos Recipe button 

Add Line 

1 
2 12 
3 3 

Position 

Descriptions and/or 
conunents may be 

inserted here. 

- 11!22:5i 

l 
5t DAK:5ilicone 

Depth Plofile:Recipe 
Depth PlOfile:Au on 55 
Depth Plofile:Au on 55 
Depth Plofile:Au on 55 

M Pelfolmance te: t ~Gold Dia nal 

Position Table Blank:CI Regin 
Position Table Blank:Au Ie iOI 

TE5T:test 2 
eosition Table Blank:Fe Rt'" 

Recipe 
pull-down 

menu 

1.00 1.00 1.00 1.00 
2.00 2.00 2.00 2.00 ... 

If, after acquiring the data set, more data is needed, create the appropriate Recipes and 
inselt them into the previous position table. 
Then Save again. 

Previously stored position tables may be reused and edited to accommodate different sets 
of samples. 

Previously stored position tables may be reused and edited to accommodate different sets 
of samples. 

Motion Control - Rotation 

Rotation II J 
~ Starts continues rotation 

Cont I I 
Stop~ 

--L-__ =.J_ L Stops continues rotation 

] 

J 
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Motion Control- System configuration. 

~MU I ION (UlillUlc!> I!I~ f3 
Motion Controls 

Joystick 
buttons 

XYZ R 

XYZ R 

[ 

Units ­

XYZ Imm 

l l>Ni:3~ I 

select one option for the Motion Control 
interface. 

Motion Control Interface -

{ None 

{ 2100 Indexers with HPIB 

Please check all installed axes. 

Installed Axes 

r;; XAxis 

Y Axis 

_J ZAxis 

RAxis 

ZAxis j 
R Axis 

--~--

Store Selection and Exit 

A.rlgl,.. DA.llr I 
f 

Enable 

).lll~1 ~ 

Cont I 
Rotation-l ~ 

Stop I Joystick I 

1. No Motors then use "None" 
2. National GPIB card us 2100 
Indexers with HPIB. 
3. New motion system use 6K4. 

On new installations, check all 
installed axes. 
If a fault message suggests you 
should uninstall a motor, remove 
the check for the reported axis. 

the check for the reported axis. 

This configuration dialog will be displayed when the software is first installed. Your 
responses will be stored in the registry. 
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Motion Control- Units, coordinates. 

[

Units J 
XYZ ~i-I m_m_=il=, R ot.3tion I deg :::oJ 

Read only - Current position 

2.3 Z:R52 R:~3 I ~
-X .. l . mm ~~=! 

L.:..ra=w..:..--,..---, ~ Manual entry - (X,Y,Z,R) ] 

XYZ Scale units are: 
1. rum = millimeters 
2. inch = inches 
3. raw = number of motor steps (250,000/ inch) 

R Scale units are: 

1. deg = degrees 
2. raw = number of motor steps (36,000/ tum - 6K4 or 25,000 / tum GPIB) 
3. tilt = converts TOA (Take Off Angle) to raw. See Motion Control- Angle 

Resolved. 

Enter position coordinates and then click Goto (or keyboard Enter) for manual control. If 
no position coordinates are entered (i.e. White boxes are empty) then the current motor 
positions will be recovered from 2100 Indexers. This is not required with 6K4. 
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Motion Control- Velocity Setup (GPIB with 2100 Indexers only) 

The Velocity Setup only controls the velocities for computer, not joystick control. 

The velocity settings are in mm!sec or deglsec, 
These settings only control the velocities for computer 
control, The ioystick velocities are set manualy in the 
21 00 inde:<ers, 

Adiustment range 

X Axis 
10,5 0,1 to 5 mm!sec 

YAxis 1°,5 0,1 to 5 mm!sec 

ZAxis 
10,5 0,1 to 5 mm!sec 

R Axis 
10,5 1 to 180 deg!sec 

Command1 

63 



MRS Tables 

A capture screen, with a new database loaded, win show no MRS table. Select a Recipe 
to load the MRS table constructor functions. 

1 t;. l?ew~SettiY;J, ,,,,, 

,D dti ~ 
U:-tII tAd'ft,·t:!lalOl 

Ae<~ 0,'_1< ___ _ 

::.:~ 
'1' Pel" O/I'T'I¥'\Ce,~t 
;;:- P~n hlle 81<ri; 
:;; S~Pro;ect 

',II 

I Area \ PMi; AUo [ ntl lools A. I ~ IQ Ril l ~ ~ I IL l <!{ 

II 

0 

0 

Ga a Pt"p3 Re<4pl Rh3p1 V2pl 

,eo ~"" ~ 5etmo' 4o:It 

' Dti'N ~ I 

Ioi DeplhPrdJe 
;:; P~lconT\.Y'lCCte;t 

' D ti' t i ~ I 

A..,.,. UI!!' JAdfTnlbetOf 
Oe.;c 

r. RecOe IDeI",~ I r ftWt"rod r. avo!( W(~e 
rE,.,...".... 

: ProiN.","1 
EI<.()tlar""·1 
E~'p OelC: IreqlOf~E~ir6lt 

""'~';I. IA ..... do!. 

I 
Scan 

~ 
r 
I 
I 

I 
I 

1'1 I 

~ One +:: 
Eoo !:"'!! 

... OtplhPrdle , Funt-boo L8E Wndow\vdh Spot Size Scam/liln$ RC$h EV/Step 
::; Pedormanco test Scovey • 0 1000 eoo " • , 
;;: Po.sI5on T ab1e Blank G Stn'ey HaJ .... 1/ 
:-:; StfrC)~Ptoied END 
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~ 

~ 
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In this case the Sample Project> Default Recipe was selected. The MRS for this Recipe 
is a simple survey. We can stalt from this MRS and modify it to create the parameter 
table for the Spectl1.lm capture desired. First, a review of the possibilities. 
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MRS Tables - Construction by selecting and editing Functions. 

Adding a new function. 

I­
I' 

I' 

Ii Ii 

1 I'~".O I 

~ I 

VI.! I 
END 

Drop down the Function menu 

1 Function 
i':f: ... 

SUivey ~ 

I 
Click on add 

function . 

- ResHi ~ .- HiSen 
UnScanned 
Depth Profile 
IOSystem 
Etch 
Neutralizer 
Label 
BLoop 
PT Single 
Xpause 

~ 

Select a Function 

Function 

Select a Function 

ResHi 
HiSen 
UnScanned 
Depth Profile 
10 System 
Etch 
Neutralizer 
Label 
BLoop 
PT Single 
X ause 

~nction menu, J 

END 

Select a function . 
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lVIRS Tables - Construction buy editing Functions cont. 

FUNCTION TABLE CONTROLS 

~Iear Clear MRS table. Leaves top function . 

Set next row up the active function 

Set next row down the active function 

Add new function 

Delete current function 

Move current function up one row 

Move current function down one row 

The controls for the manipulation of the functions in the table are described above. The 
underlined A and X can be executed from the keyboard by using Alt-A or Alt-X. 

j .u. Quick II Last Running User IAdministrato End c;-sl 
1 Function LB E \4indow Width Spot Size I S ca~s/T ime I R esl:t I EV I S te~ ... ~ 

Survey ~ 0 1000 800 11 \'" 14 11 Q. 
t--

G Survey 1000 ~ (f 

rSC~SlTime l' 

~I L 

A Function (in this case a Survey) creates a list of default data acquisition parameters. 
The default values are often ok but it is quick to customize the values. For example, the 
number of Scans is often increased or the BE conditions are changed. 

NOTE: Time, stated as hh:mm:ss, can be entered instead of number of scans. The 
program will compute a number of scans that most closely matches the requested 
time. A calculation of zero scans will be run as one scan. 

The default parameter eV/step is set optimum for the selected resolution (Res#) . 
This applies to high resolution (ResHi) and high Sensitivity (HiSen) scans. 
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MRS Tables - Construction by editing Functions cont. 

NOTE: TABor the mouse must be used to step out of the Function column. 
In the Function column the arrow keys move up and down the Function list and not 
from Function to parameter columns or Function to Function. 
The arrow keys move up and down or side to side in the parameter columns. 
SHIFT TAB will tab right to left. It is fast to fill in a table and then "arrow" down the 
scan column and set the number of scans at one time. 

High Resolution scans and High Sensitivity scans may be added to the table as required 
by the analysis. For these two cases the binding energy is changed form the default 
values. This is quickly accomplished by "Arrowing" down the BE column. 

--
1 Function LBE Window Width Spot Sizel ScanslTimel Reslll EV/Stepl ... -

... 0 1000 800 Swvey 12 14 II J -
G Survey 1000 ... (f Survey 

2 Function CBE Window Width Spot Sizel Scans/Timel Reslll EV/Stepl 
ResHi ... 284 20 300 15 12 10.065 1 
G HR R2 ... J/ C 1 s 

3 Function CBE Window Width Spot SizelScans/Timel ResllLEV/Stepl 
ResHi ... 530 20 300 13 12 10.065 1 

. G HR R2 ... (f o ls 

I 4 I Function CBE Window Width Spot Sizel ScanslTimel Reslll EV/Stepl 
ResHi ... 100 20 300 L5 12 LO.065 I 
G HR R2 ... . (f Si2p 

5 Function CBE Window Width Spot Sizel Scans/Timel ReslllEV IStepl 
ResHi ... 348 20 300 110 12 10.065 1 
G HR R2 ... (f Ca 2p "-

~ L 

1 Region name J , 

II 
... 

4 I I . , 

The above Multi Region §.can (MRS) has a survey and four high resolutions Region. 
Each region has been named for ease of identification. The region name will default to 
Region 1, Region2 etc if the names are not entered. 
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MRS Tables - Templates 

3 Function LBE ,Windov,...... """~ 
HiSen .... 50 250 Template drop-down 

r--
G Sen R4 .... (I IlowBE menu. 
Function 

Ie----
4 LBE Windm ~ ~tep 

HiSen .... 50 250 / / 11 l o: L ,~ 
t Gen R3 .... (I low 6Y" / 

5 Function LBE V~Width Spot Size IS cans/T imel R esli LEVIS tep 
HiSen .... -~ 600 16 13 1.2 . .;' ,(I' Fermi Region 

IrlGSenR4 END 
G Gen R3 

The table above displays three templates for the high sensitivity function. After selecting 
a function you can drop-down the list of named templates that hold a set of default 
values. For frequently used parameter sets you may want to define your own set of 
default templates. 

1 Function LBE WindowWidlh Spol SizelSc<lns/Tirnel Res " 1 EV/S tepl 
Swvey • 0 1000 800 2 4 1 
G Survey 1000... (f~ Survey 

2 FuncCion CBE Window Width Spot Size Scans/Time Res" EV/Slep 
ResHi • 284 20 300 5 2 0.065 
G HR R2 • U C l s 

3 Function L8E Window Width Spot Size Scans/Time Res" EV/Step 
HiSen • 50 250 800 1 4 .4 
G Sen R4 .... V low BE range 

4 Function LB E Window Width Spot Size Scans/Time Reslt EV/Step 

• 50 = mo 1 .. 
G Gen R3 • (!I row BE range 

5 Func-tion L8E WindowWidlh Spot Size Scans/Time Reslt EVISlep 
HiSen .·5 20 600 6 3.2 
Fermi edoe ... (I e'miAe~ 

/ ~
IIFelml ed9:omprate Name 

Create Date Last Modified 

12/ 8/ 2000 I 

", I I ~:E ;;dOWWidlh 
Spot Size Scans/Time 

r r 
Design button ResH EV/Slep 

r 
Set As Default II 

INo 

__________ 13 12 

r r 
Comment 

I 
[ Check to lock value 

~_I ~ ~ I ~I 
Check to lock value 

~ I /s I /s I ~ I 
~ .cancel Q,elete ~ 
lHIIl3 of 3 il!D 

I Re 4pl Rh 3p1 V 2pl 

To create a new template: 
1. Select the New Icon. 

Enter a new Template Name. 

x 

r 

] 

] 

2. 
3. 
4. 
5. 

Enter the parameter values for your template in the appropriate boxes. 
The check box will lock the value so it can't be changed from the MRS table. 
Select the Paste Icon to save the template and post the name to the Function 
list. 
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MRS Tables - Run Controls 

~ 

Run ct-=: -=====c Run button J 
One "~ - r Append r. Over Write 
End l::"E 

1 Function LBE Window Width Spot Size!Scans/Time! Res**1 EV/Stepl 
Survey ... 0 1000 800 12 14 11 1 
G Survey 1000 ... JI' Survey 

2 Function CBE Window Width Spot Sizel Scans/Timel Res**1 EV IStepl 
ResHi ... 284 20 300 15 12 10.065 1 
G HR R2 ... {! C 1 s 

• I 

[IJ \ I ,{III LII. I ~ Proi Name:1 
-- -- --- - Exp Name:1 

E xp 0 esc: .1 T empor ary Experiment 

Analysis: JRaw data 

Befor running the MRS table a Project Name and Experiment Name must be provided. 
These two names taken together create a unique ideruty for the MRS in the database. The 
Experiment Description is for additional information that make clear the Experiment. 
The discription is not used for finding the data . It is supplied after the data is recovered. 

Most of the time there will be a Project Name and Experiment Name in the input boxes. 
These names will be left from the previous state of the Capture Program. It is most likely 
you will not change the Project Name. This assumes that you will do many Experiments 
for one Project. The typical operation will be to write over or modifY the Experiment 
Name. You may add letters or numbers to show a sequence in the experiments. 

After taking care of the Project Name, Experiment Name and Description Select a Run 
Control. 

Control. 

Three Run Controls are found above the Function Table. The lines in the Function 
Table can be run to capture a sequence of regions. 
The Run button runs the complete Function Table from line 1 to the bottom of the table. 
The second button labeled One only runs the current active (highlighted) line. 
The bottom button labeled End runs from the current active line to the bottom of the 
Function TabJe.Once a capture is started additional buttons appear to control 
termination. 
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Pause, Stop, Abort and Append buttons appear to the right of the three run buttons. 

r .6.ppend Run ct:= 
r. 0 ver \\lrite 

One + = @] 
,,-.... 

~ I I - - .... _" 

User 1.6,dministr ato Ind G;"= Pause Stop Abort 

Pause - MRS tables. Pause will temporarily stop the capture so a change can be made 
to the number of scans or capture time. In order to continue, click again on Pause. 

Pause - Depth Profiles. Pause will temporarily stop the capture of a scan. During the 
pause the etch time or number of cycles may be changed. In order to continue, click 
again on Pause. If Pause is used during the etch cycle the current etch cycle will fmish 
and then the Pause will be executed. 

Pause - Position Tables. Pause will effect the MRS table of the current position. 

Pause - Ion Etch, The stand alone Etch function will pause during the etch. The etch 
time can be changed. 

Stop - MRS Table. "Stop" is used to stop a scan at the nearest endpoint. If the 
capture is unscanned then the capture will stop immediately. 

Stop - Depth Profiles. "Stop" acts as an abort during a the Depth Profile. 

Stop - Position Tables. "Stop" will stop the Position Table MRS at the end of the 
running spectrum. The Position table will be aborted. 

Abort stops all operations immediately. The data taken up to the time of the Abort is 
saved. 

Abort stops all operations immediately. The data taken up to the time of the Abort is 
saved. 

Append: Normal operation is Overwrite. If a new experiment name is not entered, 
then the re-run of the current experiment overwrites the existing data. If you want to 
collect additional data under the current experiment name then you may use the Append 
mode. Tbis can be used to add a new region to the experiment or to collect additional 
data for one or more regions. The Appended data may easily be added to the original 
data by using the Add Spectra function in the Tools menu. The Append mode reverts 
back to the overwrite mode after the Appended data has been collected. 
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MRS Tables - Run display 

The data being acquired will be visible in the Spectrum Viewer. 
During data acquisition binding energies may be measured by placing the cursor on the 
peaks, their binding energies can be seen below in the Display Bar. 

P,oj Name:IDela,,1l 
Exp Nome:Ir.Te-m-p -------

Scan 

Exp Oesc: Ishaft scan 

Anail',is: l""Aa-IV--'d~-a-------
2.SK I XolI, 

SUlve 0 

21< 
r--=C~1s ______ _ ___ @ 

1.51( 

lK 

500 

550 500 450 400 3SO 300 250 200 150 100 50 o I~.~ _________ _ 
[eV:2812, Co"nl,: 1156 

Capture Status Display Bar Scofield Table 

The Spectrum Viewer is used to display the current active spectrum and it will always 
be displayed in this window during data acquisition. 
Below the Spectrum Viewer/ Document Control area is a display bar that shows the 
status of the capture process. 
During a capture the Idle indicator will switch to Running. 
The information inside of the parenthesis will show the Recipe that is being run. 
Additional parameters of the capture will also be displayed in this window. 
:;UHU:; Ul lllt; U:1VlUI t; VI UCt;:;:;. 

During a capture the Idle indicator will switch to Running. 
The information inside of the parenthesis will show the Recipe that is being run. 
Additional parameters of the capture will also be displayed in this window. 
The next window in the Status Bar displays the cursor parameters. 
The third window displays the Scofield Table showing probable peak assignments as a 
function of cursor position. 
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Next section is Data Analysis 

The data analysis provide for Compositional Analysis, Peak Fitting, Depth Profile 
analysis and other data manipulation. 

To open the Data Analysis from the Capture program Click on View> Data Reduction. 
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